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About This Book

This document contains information to help you install, get started, and perform tasks with the Interactive
Code Analysis Tool (ICAT) debugger.

If you need assistance from any window while using the debugger, press F1 from any window or choose
the Help menu.
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Introducing the ICAT Debugger

The IBM Interactive Code Analysis Tool (ICAT) is a debugger that enables developers to debug applica-
tions running on an IBM 4758 PCI Cryptographic Coprocessor. The debugger provides a graphical user
interface that enables a developer to:

¢ Locate the current point of execution within an application and view the source that corresponds to
that location.

¢ Examine and modify an application’s state, including variables and registers.

¢ Set breakpoints and execute machine instructions or source statements one-by-one.

e Dump the contents of the call stack.

¢ Intercept and diagnose exceptions generated by an application.

The ICAT debugger (hereafter referred to in this document as the debugger) is a source-level debugger
that runs on a Windows NT or a Windows 2000 system and interacts with a special version of the CP/Q++
operating system running on the coprocessor. The debugger can communicate with CP/Q++ through the
PCI bus (if the coprocessor is installed in the host where the debugger is running) or through a null-
modem serial cable.

Before You Begin

This section lists the hardware and software requirements, options that can be used when compiling and
linking your program, environment variables, and the search order of source files and modules.

Minimum Hardware Requirements

¢ Intel® x86® 150MHz processor

e 11 MB hard disk space

e [f ICAT is to communicate with CP/Q++ through a null-modem serial cable, the COM port over which
ICAT communicates must work reliably at 57600 baud (that is, it should be equipped with buffered
UARTS).

Installation

ICAT is part of the IBM 4758 Application Program Development Toolkit, which includes three versions of
the CP/Q++ operating system. The debug versions incorporate a “probe” that acts as ICAT’s proxy and
manipulates the application under debug. The production version does not. The debug versions must be
loaded into segment 2 of the PCI cryptographic coprocessor in order to debug applications. For details,
refer to the IBM 4758 Cryptographic Coprocessor Custom Software Developer’s Toolkit Guide and the IBM
4758 PCI Cryptographic Coprocessor Custom Software Installation Manual located on the Library page of
the IBM 4758 Web site at www.ibm.com/security/cryptocards/.

Environment Variables

The debugger uses environment variables to manage debugging sessions and remote communication. To
set the environmental variables, edit the SETICAT.BAT file. Set the environment variables carefully in the
session or command prompt window from which the debugger is invoked. Following is a list of the vari-
ables and a description of each:

CAT_COMMUNICATION_TYPE
Specifies whether ICAT is to communicate with CP/Q++ through the PCI bus or through a
serial port.

© Copyright IBM Corp. 1997, 2001 3



For example, type the following at the command prompt to communicate with CP/Q++ through
a serial port:

SET CAT_COMMUNICATION_TYPE=ASYNC_SIGBRK

For example, type the following at the command prompt to communicate with CP/Q++ through
the PCI bus:

SET CAT_COMMUNICATION TYPE=PCI

CAT_MACHINE
Specifies which host com port the debugger uses to communicate with the cryptographic
adapter. A single host may contain more than one coprocessor card. The host device driver
assigns each coprocessor a unique number, starting with zero. (The number assigned to a
particular coprocessor depends on the order in which information about devices in the system
is presented to the device driver by the host operating system and currently there is no way to
tell a priori which coprocessor will be assigned number 0, which will be assigned number 1,
and so on. If CAT_COMMUNICATION_TYPE=PCI, CAT_MACHINE must be set to the number
assigned to the cryptographic coprocessor on which the application to be debugged will run.
For example,

SET CAT_MACHINE=0
If CAT_COMMUNICATION_TYPE=ASYNC_SIGBRK, CAT_MACHINE identifies the host COM
port over which ICAT will communicate with CP/Q++. For example,
SET CAT_MACHINE=COM1
CAT_HOST_BIN_PATH
Tells the debugger where to find your debug binary (the .XLD file with debug information) on

your host system. See [‘Finding Source Files” on page 6| for a description of how this environ-
ment variable is used.

For example, type the following at the command prompt:
SET CAT_HOST_BIN_PATH=I:\4758TEST
CAT_HOST_SOURCE_PATH

Tells the debugger where to find your source (for example, rte.c in the demonstration session).
See [‘Finding Source Files” on page 6|for more details.

For example, type the following at the command prompt:
SET CAT_HOST_SOURCE_PATH=I:\4758TEST
CAT_PATH_RECURSE
Causes a recursive search of the subdirectories below the subdirectories listed in
CAT_HOST _BIN_PATH and CAT_HOST_SOURCE_PATH. For example, with the
CAT_HOST_SOURCE_PATH=I:\4758TEST variable, the debugger searches the 4758TEST
subdirectory and all subdirectories below 4758TEST as well as their subdirectories. The
default is NULL, which means the debugger will not perform a recursive search. When the
variable is set to any non-null value, the recursive search is performed.
For example, type the following at the command prompt:
SET CAT_PATH_RECURSE=ON
IPF_PATH32

Locates the IPF32.DLL for the debugger to run correctly. For example, type the following at
the command prompt:

SET IPF_PATH32=%SCCTK_FS ROOT%
The debugger finds IPF_PTH32 in %SCCTK_FS_ROOT%\bin.
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CAT_OVERRIDE
Specifies a path that the debugger searches first to find the source files used to build your
debug binaries. See [‘Finding Source Files” on page 6|for a complete description of the
process.

For example, type the following at the command prompt:
SET CAT_OVERRIDE=E:\TEMP\UPDATES
CAT_TAB
Specifies the number of spaces between tab stops when source code containing tabs is dis-
played in a debugger window.
For example, type the following at the command prompt:
SET CAT_TAB=5

The debugger converts each tab in the source to five spaces when the source is displayed.

CAT_TAB_GRID
Specifies the column positions for the tab stops when source code containing tabs is displayed
in a debugger window.

For example, typing the following command at the command prompt sets tab stops at the 6th
position:
SET CAT_TAB_GRID=6
CAT_DEBUG_NUMBER_OF_ELEMENTS
Represents the default number of elements displayed for a variable or structure that has a

substantial number of elements. The last element displayed for such a structure is labeled
“more elements.” Clicking on this entry displays the next n elements of the variable or struc-

ture.
Note: CAT_DEBUG_NUMBER_OF_ELEMENTS is an environment variable that is set to an
integer, n.

For example, type the following at the command prompt:
SET CAT_DEBUG_NUMBER_OF ELEMENTS=100

The next 100 elements are displayed.
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Finding Source Files

The debugger searches for the source files in the following order:

1.
2.

CAT_OVERRIDE environment variable.

The subdirectory in which the object file generated from the source was compiled (as indicated by
debug information in the executable file.)

3. CAT_HOST_BIN_PATH environment variable.

. The subdirectory in which the translated (.XLD) file was found.

5. CAT_HOST_SOURCE_PATH environment variable, descending subdirectories if the

CAT_PATH_RECURSE environment variable is set.

. The current directory.
. The path defined in the INCLUDE environment variable.
. The last specified subdirectory from the "change source file" function.

. If ICAT cannot find the source in any of the previously mentioned locations, it prompts the user to

enter the location of the required source file.

The debugger searches for the executable (.XLD) file in the following order:

1.
2.

Current directory.
CAT_HOST_BIN_PATH environment variable.

Note: The CAT_PATH_RECURSE environment variable, if specified, causes the debugger to search
recursively all subdirectories of the CAT_HOST_BIN_PATH and CAT_HOST_SOURCE_PATH environ-
ment variables.

Limitations

The debugger has the following restrictions:

The debugger can not currently launch an application to be debugged (that is, cannot cause an appli-
cation to be loaded into the cryptographic coprocessor and assume control of the application before
any instructions in the application have been executed). The earliest point at which the debugger can
attach to an application (that is, assume control of the application and place it under debug) is after
the application’s main entry point has been invoked. If you want to make certain that your application
does not make progress before the debugger has a chance to attach, you must code an infinite loop
at the beginning of the application (and use the debugger to change the point of execution to the
statement following the loop after attaching).

If the debugger is communicating with CP/Q++ through a serial port, no other application on the host
can access that port.

Applications to be debugged must be compiled and linked in such a way that the application execut-
able incorporates debug information. Otherwise the debugger cannot be used to examine and manip-
ulate the application at the source level. However, only the copy of the application executable that the
debugger reads must have this information; the copy downloaded to the coprocessor can be reduced
in size by stripping debug information from it before it is downloaded.

ICAT does not handle certain coding styles well. For example, it can be difficult to debug a program
that has more than one source statement on a line—the debug information available to the debugger
forces the debugger to treat the entire line as a single statement. Thus, you cannot set a breakpoint
on, say the second statement on the line, nor can you step through each statement.
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Getting Started

This section describes how to start a debugging session, set up the coprocessor and the host, and how to
end a debugging session.

Setting up the Coprocessor

To set up the coprocessor:

1. Follow the instructions for installation in the IBM 4758 Cryptographic Coprocessor Custom Software
Developer’'s Toolkit Guide to install the coprocessor and use the CLU utility to load the TPRrrrss.clu
(the debug kernels) onto the coprocessor.

2. Use the DRUID utility to load your application and start it running for debugging. The application
should have an infinite loop near the beginning of the code, as recommended in IBM 4758
Cryptographic Coprocessor Custom Software Developer's Toolkit Guide.

Setting up the Host Computer

To set up the host Windows NT or Windows 2000 computer:

1. Install the IBM 4758 toolkit. The debugger is packaged as part of the toolkit in the ...\scctk\bin\nt
directory.

2. Ensure that the ...\scctk\bin\nt directory is in the path.

3. Set the environment variables. See [‘Environment Variables” on page 3 for more information.

Demonstration Session

The following session demonstrates the debugger manipulating the code on the coprocessor.

1. Inspect the scctk\src\samples\rte subdirectory on your host computer. This subdirectory contains the
.C source files and the makefiles to make the binaries that the debugger must see on your host com-
puter.

2. Change the rtent.mak makefile to ensure that the variable DEBUG is defined (/DDEBUG). This
ensures that the attachment loop is included in the executable.

3. Make the rte executable. The executable will be saved at ...\scctk\obj\samples\rte\nt\(bld_env) where

(bld_env) is msvecmasm for Microsoft Visual C++ or vacppmsm for IBM Visual Age C++.

. Translate the executable file to an XLD file, using the CPQXLT utility.

. Translate the XLD file into a ROD (read-only disk) file using the sccrodsk utility.

. On the coprocessor, ensure that you have loaded the debug kernel (TPRrrrss.CLU).

. Use DRUID to load the ROD file onto the coprocessor.

. On the host computer, modify SETICAT.BAT as described in [‘Environment Variables” on page 3|so
that the CAT_MACHINE environment variable includes the number of the coprocessor you wish to
debug. Now, run SETICAT.BAT to set up the environment variables, run ICATCPW.EXE, and then
wait for the Launch or Attach dialog box to display.

9. From the Launch or Attach dialog box, enter rte in the Program field. Click the Attach button and
click OK to attach the program. (Program launching is not supported, the loader launches the
program when it is loaded into the coprocessor.) It will take some time, but the Debug Session
Control window will be displayed, with the rte application in the component list.

10. Click the plus sign located beside the path name for the RTE.XLD file in the Debug Session Control
window. The path expands to display a list of functions within the file. Double-click rte to open the
Source window for rte. The function should pause within the infinite loop.

11. Select a Mixed view and notice that we mix the disassembly with the C source. Switch back to a
Source view.

12. Set a breakpoint within the infinite loop, then set the debugger to Run.

0o ~NO O b
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13. Next do a jump to line 34 (after the infinite loop). At this point, you can debug the program normally.
However, if you hit run, the system will stop on sccGetRequest(), since no host function has asked for
service yet.

14. From the host, run the hre.exe application.

15. When the debugger hits a breakpoint, display a mixed view. Single step the MASM code a couple of
times. Switch back to a source view. Next, set a breakpoint at line 58, and run again. When you hit
that breakpoint, you can double-click variables, do a call stack unwind, show a Register window or a
Storage window, and so on.

This concludes the demonstration session.

Starting a Debug Session
Load the program you wish to debug on the coprocessor.

To start the debugger:

1. From the Windows NT or Windows 2000 command prompt, enter ICATCPW followed by one of the
following parameters:

/P+ Use program profile information (the default).

/P- Do not use any program profile information.

The Launch or attach window is displayed.

Program

|| ||EI ‘ Browse... I

Parameters

® Launch
O Attach

[] Use program profile
[] Debug program initialization

| 0K I | Beset I | Default I | Settings I |Cance|| |He|p|

Figure 1. Launch or attach Window

Note: It's usually a good idea to have set up your environment variables by way of a SETICAT.BAT
file before invoking the debugger. See [‘Environment Variables” on page 3|for more information.

2. If you're going to debug a program more than once, select the Use program profile check box to
reactivate the windows and breakpoints.

3. Enter the name of the program to be launched in the Program field. You can click the Browse button
and select a program from the list of files.

4. Click Attach.

Note: The Launch option is currently unsupported.
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5. Click OK. The Debug Session Control window opens displaying the threads and components of your

source.

Reset returns the window settings to the values you defined upon initialization of the window.

The Default button restores the window’s default settings.

The Settings button displays the Debugger Properties window, which enables you to select how threads
and source files are initially displayed and enables you to set environment variables. See

[Debugger Properties” on page 19 for more information.

Using the Tool Buttons

A tool bar has been provided on the debugger windows for easier access to frequently used features. To
display buttons in a window, enable the Tool buttons choice that is listed under the Options menu. The
following is a list of features that are provided:

=

T

&)

1 (T

]

Step over executes the current line in the program. If the current line is a call,
execution is halted when the call is completed.

Step into executes the current line in the program. If the current line is a call,
execution is halted at the first statement in the called function.

Step debug executes the current line in the program. The debugger steps over any
function for which debugging information is not available (for example, library and
system routines) and steps into any function for which debugging information is
available.

Step return automatically executes the lines of code up to and including the return
statement of the current function.

Run enables you to start and stop the program. When the debugger is running, the

Run button is disabled and the Halt button i‘*l is enabled. You can click the Halt
button to halt the program execution. You can also interrupt the program you are
debugging by selecting the Halt choice from the Run menu.

View changes the current source window to one of the other source windows. For
example, you can switch from the Disassembly window to the Mixed window.

Monitor Expression enables you to type in the name of the expression you want to
monitor.

Call Stack enables you to view all of the active functions for a particular thread
including the system calls. The functions are displayed in the order that they were
called.

Registers enables you to view all the processor and coprocessor registers for a
particular thread. This is useful only for native-binary debugging.

Storage displays the storage contents and the address of the storage. This is
useful only for native-binary debugging.

Introducing the ICAT Debugger 9



i

Breakpoints enables you to view all the breakpoints that have been set.

Debug Session Control displays the Debug Session Control window. This is the
main window for the debugger and runs during the complete session.

[©]

Growth direction enables you to change the direction that items are displayed on
the stack.

Delete enables you to delete the selected item.

Delete all enables you to delete all the items in the window.

32-float displays the storage contents as a 32-bit floating point/number.
64-float displays the storage contents as a 64-bit floating point/number.

32-bit unsigned displays the storage contents as a 32-bit unsigned integer.

LU L %E %H W b
|_m I"\J - - o

32-bit signed displays the storage contents as a 32-bit signed integer.

I
m
A

ASCII displays the storage contents in ASCII.

Hex and ASCII displays the storage contents in Hex and ASCII.

I o
EIREE

Change representation enables you to change the data representation.

Helpful Tips and Hints

The following tips and hints may be helpful:
¢ You must have Windows NT or Windows 2000 on your host computer.

e Put any environment variables that you want set in a command file. For example, you could put them
in the SETICAT.BAT file or create your own command file.

¢ The code translator (CPQXLT.EXE) can be used with the /NODEBUG option to strip debug informa-
tion from the EXE file before building a .ROD file to be loaded on the coprocessor. However, this
XLD file should not be in the CAT_HOST_BIN_PATH of the debugger before the .XLD file containing
debug information.

e Using C, you can write your program code with stylistic features that are not supported by the
debugger. For example, multiple statements on the same line are difficult to debug. None of the
individual statements can be accessed separately when you set breakpoints or when you use step
commands.

Troubleshooting

Following are some things to check when the debugger is not doing what you think it should:
¢ If the debugger can’t attach to the application under debug:

— If you have just loaded your code onto the coprocessor, wait a couple of minutes. The loader may
take some time to run the program to the point at which it can be attached.

— If you are using the serial port to debug, ensure that your serial cable is a “null-modem” cable (a
cable that connects the transmit data pin of one machine to the receive data pin of the other).
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— If you are using the serial port to debug, ensure that your serial cable is securely attached to both
the host computer and the target coprocessor.

— If you are using the serial port to debug, ensure that the serial cable is connected to the COM port
on the host computer which is specified with the CAT_MACHINE environment variable and that
the CAT_COMMUNICATION_TYPE environment variable is set to ASYNC_SIGBRK.

— If you are using the serial port to debug, ensure that you have buffered UARTs on the host com-
puter and that you are using 57600 baud.

— If you run the debugger on a notebook computer, ensure that your communication port is enabled
and powered on.

— Ensure that the debug kernel is installed on the target coprocessor and that your application has
been loaded onto the coprocessor.

— Ensure that CAT_HOST_ BIN_PATH is set to the proper path.
¢ |f the debugger only displays the disassembly listing of your program and not the source listing:
— Ensure that the program was compiled with the proper flags to enable source-level debugging.

— Ensure that the .XLD file in the CAT_HOST_BIN_PATH was not processed by a debug stripper
utility. Debug stripper utilities make the DLLs smaller by removing the debug information.

— Ensure that your CAT_HOST_SOURCE_PATH is set to reference your source files.

— Ensure that ICATCPW was not run from a directory containing a non-debug version of your XLD
files.

Ending the Debugging Session

To end the debugging session, click Close debugger (located within the File menu) from any of the
debugger windows. The Close Debugger window is displayed. Select one of the following choices:

¢ Select Yes to end your debugging session.
e Select No to return to the previous screen without exiting the debugger.

You can also end the debugging session by pressing F3 in any of the debugger windows.

Introducing the ICAT Debugger 11
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Main Debugging Windows

This section introduces the Debug Session Control window and how to perform functions from this
window. It also introduces the three source windows that offer different views of your source code.

Debug Session Control Window
The Debug Session Control window is the control window of the debugger and is displayed during the
entire debugging session. This window is divided into two panes: Threads and Components.

¢ The Threads pane contains the threads, their names, and the state of the threads started by your
program. To display the state of a thread, click the plus icon to the left of the thread.

Right-click on a selected item to display the Thread menu and press F1 to view help for this item.

¢ The Components pane shows the path names of the modules that you are debugging.

Right-click on a selected item to display the Component menu and press F1 to view help for this item.

= ICATCPYW - Debug Session Control n - |
File Breakpoints Monitors Bun Options Windows
Help

STATUS : Ready.

Threads galactic
Thread: 1| GACPQTESTAGALACTIC

Figure 2. Debug Session Control Window

From the Debug Session Control window you can select menus that enable you to:

e Open a new source file.

¢ Open a source window to a particular function.

e Open a source window containing the next line to be executed.

e Save the contents of the Threads pane or the Components pane into a file.
¢ Set line, function, address, watchpoint, or load occurrence breakpoints.
¢ Display a list of breakpoints that have been set.

¢ Monitor the call stack for a particular thread.

¢ Monitor registers and flags for a particular component or thread.

¢ Display the local variables for your application's current function.

¢ Execute your application or stop execution.

¢ Modify how the debugger window is displayed.

© Copyright IBM Corp. 1997, 2001

13



Opening a New Source File

You can open additional source files from the Debug Session Control window.

To open a new source file:

1.
2.

6.

Click Open New Source (located within the File menu).
Type the name of the object file you want to open the source for in the Source field.

For example, to look for the source used to compile A123.0BJ, type the following in the Source field:
A123

If you are uncertain of the file name, click the File list button to view a list of the files that you can
select.

. Type the name of the executable file in the Executable field. The source files for the executable file

are displayed in the Source field.

. Select the All executables check box if you want to search all the executable files. Clear the All

executables check box to search for a particular executable file.

. Select the Debugging information only check box if you want to search only the source files that

contain debugging information.
Click the OK button.

Opening a Source File to a Function

You can use the Find Function window to open a source window to a particular function.

1.
2.

3.

4.

5.

Click Find Function (located within the File menu).
Type the name of the function you want to search for in the Function field.

If the function that you specify is not found, the following message is displayed:
No matching function found. Desired function could be static.
This means it might be a static function or the function you specified does not exist.

The debugger searches each object file for global functions that match the function name specified. If
an object file contains the global function that was specified, then it also searches that file for any
static function with the same name.

Select the Debugging information only check box if you want to search only the object files that
contain debugging information.

Select the Case sensitive check box if you want to search for the string exactly as typed. Clear this
check box if you want to search for both uppercase and lowercase characters.

Click the OK button.

Locating the Execution Point

To locate the execution point in your source, click Where is execution point (located within the File
menu). A source window is displayed containing the next line to be executed.

Saving the Contents of the Threads Pane View

If you want to save the contents of the Threads pane view in a file, click Save thread list in file (located
within the File menu). This saves the view in a file named THREADS.OUT. To change the default file
name, click Options, Windows settings, and then Display style (located within the Debug Session
Control window) and type the file name in the Threads output file field.

14
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Saving the Contents of the Components Pane View

If you would like to save the contents of the Components pane view in a file, click Save component list
in file (located within the File menu). This saves the view in a file named COMPS.OUT. To change the
default file name, click Options, Window Settings, and then Display Style (located within the Debug
Session Control window) and type the file name in the Components output file field.

Opening the Launch or attach Window

If you want to start a debugging session, click File and then Launch or attach (located within the Debug
Session Control window). The Launch or attach window is displayed. See [‘Starting a Debug Session” on|
[page 8| for more information.

Setting Breakpoints

You can control program execution by setting breakpoints. A breakpoint stops the execution of your
program at a specific location or when a specific event occurs.

To set breakpoints, click the Breakpoints menu (located on the Debug Session Control window or located
on any source window), and then click the appropriate choice for the type of breakpoint you want to set.
When you set a breakpoint in one source window, it is reflected in the other source windows. In addition,
you can set a simple line breakpoint in a source window using either the mouse or the keyboard:

¢ To set a breakpoint with the mouse, double-click in the prefix area of an executable statement (the
prefix area is the area to the left of the source code where line numbers or addresses are displayed);
the prefix area is displayed in red to indicate that the breakpoint has been set. Double-click in the
same prefix area to delete the breakpoint.

¢ To set a breakpoint with the keyboard, move the cursor to the prefix area and then press the
Spacebar to set or delete a breakpoint.

Note: You can set as many breakpoints as you want.

You can set either line, function, address, or watchpoint breakpoints.

Setting a Line Breakpoint
A line breakpoint enables you to stop the execution of your program at a specific line number.

You set a line breakpoint from the Line Breakpoint window. To display the window, from the Breakpoints
menu, click Set line.
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Figure 3. Line Breakpoint Window

The Line Breakpoint window is divided into two group headings: Required Parameters and Optional
Parameters.

Required Parameters:

1. Type the executable name or click an executable located within the drop-down list in the Executable
field.

. Select the executable file in which you want to set the breakpoint.

. Type the source name or click a source name located within the drop-down list in the Source field.

. Select the source name where you want to set the breakpoint.

. If the source you selected has include files with executable statements, type the name of the file in the
File (optional) field or click the file name located within the drop-down list. All the file names that
contain executable lines are displayed in the drop-down list.

6. Select the file where you want to set the breakpoint.

7. Type the line number where you want to set the breakpoint in the Line field.

a b~ wN

Optional Parameters:

1. Click the drop-down list in the Thread field.
2. Select the thread where you want to set the breakpoint.

Click Every, the default, to set a breakpoint in all of the active threads in your program. The Every
choice is thread independent. Select one of the individual threads to set a breakpoint in only one
thread. Threads are added to the Thread list as new threads are activated. Type a number in the
From field to activate the breakpoint the nth time the location is encountered.

3. Type a number in the To field to stop activating the breakpoint after the nth time the location is
encountered.

4. Type a number in the Every field to indicate how often the breakpoint should be activated within the
From and To range.

Note: The Frequency fields (From, To, and Every) are used for location, address, and load occur-
rence breakpoints.
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5.

6.

If you are setting an address, function, or line breakpoint, you can also type an expression in the
Expression field. The execution of the program stops only if this condition tests true. For example,
you could type the following:

(i==1) | | (j==k) && (k!=5)

Note: Variables in a conditional expression associated with a function breakpoint are limited to any
static or global variables that are known to the called function when the function is called. The
debugger does not always evaluate local variables and automatic variables correctly. The maximum
length of the condition is 256 characters.

Click Set to set the breakpoint.

Setting a Function Breakpoint

A function breakpoint stops the execution of your application when the first instruction of the function is
encountered where the breakpoint has been set.

You set a function breakpoint from the Function Breakpoint window. To display the window, click Set
function (located within the Breakpoints menu).

To set a function breakpoint:

1.

ga b~ wN

»

9.

Type an executable name or click an executable located within the drop-down list in the Executable
field.

. Select the executable file where you want to set the breakpoint.

. Type the source name or click a source name located within the drop-down list in the Source field.
. Select the source where you want to set the breakpoint.

. Type the name of the function in the Function field where you want to set the breakpoint or click a

function located within the Function list.

. Select the Debugging information only check box if you want to search only the object files that

contain debugging information.

. Select the Case sensitive check box if you want to search for the string exactly as typed. Clear this

check box if you want to search for both uppercase and lowercase characters.

. Click or type optional parameters (if any).

For a description of the fields under the Optional Parameters group heading, see Optional Paramete
on page [16]
Click Set to set the breakpoint.

Setting an Address Breakpoint

An address breakpoint enables you to stop the execution of your application at a specific address.

You set an address breakpoint from the Address Breakpoint window. To display the window, click Set
address (located on the Breakpoints menu).

To set an address breakpoint:

1.

Type the name of the address or expression where you want to set the breakpoint in the Address
field.

For example, to set an address breakpoint for the address 0xO00A1FCC, type one of the following:
0x000A1FCC or ALFCC

The 0x is optional.

Main Debugging Windows
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2. Click or type optional parameters (if any).

For a description of the fields under the Optional Parameters group heading, see Optional Parameters
on page [16]
3. Click Set to set the breakpoint.

Setting a Watchpoint

A watchpoint stops the execution of your application when the contents of memory at a given address are
referenced or when an instruction is fetched from a particular address.

You set a watchpoint from the Watchpoint window. To display the window, click Set watchpoint (located
within the Breakpoints menu).
To set a watchpoint:

1. Type a hexadecimal address or an expression that can be evaluated to a hexadecimal address in the
Address (or expression) field.

Note: If you type ABC in the Address (or expression) field, and there is a variable named ABC, the
value of the variable is used instead of the hex value ABC. Also, you can type &a in the field to set the
watchpoint on the address of variable a.

For example, type the following in the field to set a watchpoint for the address &variable.

&variable
2. Click the Watchpoint Type.

The debugger supports four types of watchpoints. They are as follows:

Read Causes a break when the address is read.

Write Causes a break when the address is written to.

Read or write Causes a break when the address is read from or written to.
Instruction fetch Causes a break when the instruction at that address is fetched.

Attention: If you set a watchpoint that is on the call stack, you should remove the watchpoint before
leaving the routine associated with the watchpoint. Otherwise, when you return from the routine, the
routine’s stack frame is removed from the stack leaving the watchpoint intact. Any other routine that
gets loaded on the stack then contains the watchpoint. You can set up to four watchpoints.

3. Click or type optional parameters (if any).

For a description of the Optional Parameters group heading, see Optional Parameters on page [16]
4. Click Set to set the watchpoint.

Note: The debugger monitors 1, 2, or 4 bytes for the type of watchpoint operation that you select. This
choice is made for you on the Instruction fetch type.

Viewing a List of Breakpoints

The Breakpoints List window lists all the breakpoints that have been set in your application. It also dis-
plays the state of each breakpoint.

To display the Breakpoints List window, click List (located within the Breakpoints menu of the Debug
Session Control window).
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Type | Executable | Source File Function Line | Address
Line GALACTIC galactic | GALACTIC.C | main 136 0x04( +]
Line GALACTIC galactic | GALACTIC.C | main 111 D0 AL

Line GALACTIC galactic | GALACTIC.C | main 144 DDAl

Line GALACTIC galactic | GALACTIC.C | main 147 D0 AL

Line GALACTIC galactic | GALACTIC.C | main 151 DDAl

Figure 4. Breakpoints List Window

Note: Multiple breakpoints can be set on the same line. All occurrences are displayed in the breakpoint

list.

The following information is provided for each breakpoint:

¢ The type of breakpoint
¢ The position of the breakpoint

The enablement state
The conditions under which the breakpoint is activated

From the menu on this window you can:

¢ Close your current debugging session.
¢ Delete, disable, and modify breakpoints.
¢ Set line, function, address, watchpoint breakpoints.

¢ Modify how the information in the window is displayed.
¢ View a list of open windows and select any open window to display that window.

¢ Display help.

Setting Debugger Properties

From the Debug Session Control window click Options, Debugger settings, and then Debugger proper-
ties to select how the threads and source files are initially displayed. The Debugger Properties window

contains two tabs:

¢ Remote
e Source
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Remote Page

When you click the Remote tab (located on the Debugger Properties window), the following page is dis-
played:

Debugger Properties

Baud Rate Environment Yariables

Host source path:

Host binary path:

Communication mode:

pCl =

Remote binary path:

I S B B

Communication port |

| &

-

PCl

| | Close | Help |

"1= Hﬂmﬂtﬂ

Source

Figure 5. Debugger Properties Window - Remote Page

From the Remote page you can:

e Set the communication baud rate.

¢ Set the communication port.

¢ Set the path where the debugger finds the source.

¢ Set the path where the debugger finds the debug binary modules.

¢ View the communication mode (ASYNC_SIGBRK for serial or PCI for direct).

¢ Set the option for recursive subdirectory searching of the source and binary paths.
¢ Set the remote path for the probe to use to find the debug binary modules.

Note: The values for this window are dithered and cannot be changed after communication has been
established with the target coprocessor.

To change your communication setting paths dynamically before communication is established with the
target computer, adjust any of the Environment Variables fields. See [‘Environment Variables” on page 3|
for detailed information on environment variables.

20 ICAT Debugger



These fields correspond, respectively, to the following environment variables:

¢ CAT_MACHINE (first two fields)
CAT_PATH_RECURSE (check box)
CAT_HOST_SOURCE_PATH
CAT_HOST_BIN_PATH
CAT_COMMUNICATION_TYPE

If you select the Recursive file searching check box, the debugger searches all source and binary path
subdirectories recursively.

Source Page

When you click the Source tab (located on the Debugger Properties window), the following page is dis-
played:

= Debugger Properties

rDisplay at stop———— Settings
@ Only stopping thread L] Multiple views
> All threads
r0ld Source Disposition—— rMouse Button 2 Behavior
O Keep ® Popup menus
> Minimize (> Step always
® Discard {2 Popup menus and step in white space

|&|]|]|‘y" | | Heset | | Default | | Close | |HE||]|

Remote

Figure 6. Debugger Properties Window - Source Page

Use this page to determine:

¢ When a source window is displayed during a debugging session.
e How to process a source window from which execution has just left. The window can remain dis-
played, be turned into an icon, or be discarded.

To display the source view of all threads or a particular thread when execution stops, choose any
selection located under the Display at stop group heading.
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In the course of debugging, the Old Source Disposition selections enable you to control the behavior of
source windows following command execution. These radio buttons control the behavior of source
windows within a thread.

The dispositions that the views can take are:

Keep Leaves open the source windows that contain the components and threads that you select with
Display at stop.

Minimize Changes into icons the views that contain the components and threads that you select with
Display at stop.

Discard Disposes of the views that contain the components and threads that you select with Display at
stop.

You can choose to display more than one source window for a particular source file. Enable the Multiple
views check box located under the Settings group heading if you want to have multiple source windows
open at the same time.

To select functions you want to perform with the right mouse button, choose the radio button that repres-
ents the action located under Mouse Button 2 Behavior.

Setting Monitor Properties

To select the settings for monitoring variables or expressions:

1. From the Debug Session Control window click Options, Debugger settings, and then Monitor prop-
erties. The Monitor Properties window is displayed.

= Monitor Properties

rMonitor Location——— Popup Duration
Z Popup monitor  Stepjrun
O Priwvate monitor Y New source
®Program monitor (J Permanent
 Storage monitor

Save file| qon.out

Mumber of elements to show | g

] Enable bubble variables

| 0K I | Reset I ‘ Default I |Canct:l| |HE||]I

Figure 7. Monitor Properties Window

From this window you can set the window into which the variable or expression being monitored is
placed or for expression windows, how long the monitor windows are displayed.
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2. Define the monitor window that opens when you select a variable or expression to monitor. Following
are the selections you can make and the corresponding windows:

Popup monitor Display the variable or expression in an expression window.
Private monitor Display the variable or expression in the Private Monitor window.
Program monitor Display the variable or expression in the Program Monitor window.
Storage monitor Display the variable or expression in the Storage window.

3. If you click Popup monitor, click one of the following radio buttons to specify how long the expression
window is displayed:

Step/run The monitor window closes when the next step command or Run is executed.
New source The monitor window closes when execution stops in a new source file.

Permanent This monitor window is associated with a specific source window and closes when the
associated source window closes.

4. Type a file name and extension in the Save file field to identify where all monitor windows will save
their contents.

5. The Number of elements to show field identifies the maximum number of structure or class elements
that are displayed at one time for a given variable in the monitors.

6. Select the Enable bubble variables check box if you want a bubble value for the contents of a vari-
able to appear as you place the mouse pointer over the variable in the Source, Disassembly, and
Mixed view windows.

Viewing Your Source

A source window enables you to view the program you are debugging. You can view your source in one
of the following windows:

e Source
¢ Disassembly
¢ Mixed

Source Window

A source window is thread specific. Executable lines are initially displayed in blue, and nonexecutable
lines are initially displayed in black. Lines with breakpoints have a red prefix, and lines with disabled
breakpoints have a green prefix.

The Source window displays the source code for the current function of the program being debugged. If

source is available, the Source window is displayed with the Debug Session Control window when the
debugging session starts; otherwise, the Disassembly window is displayed.
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Figure 8. Source Window

Disassembly Window

The Disassembly window displays the assembler or bytecode instructions for your program without sym-
bolic information.
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Figure 9. Disassembly Window
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Mixed Window
The Mixed window displays your program as follows:

¢ Each line of source code is prefixed by its line number as in the Source window.

e Each disassembled line is prefixed by an address as in the Disassembly window.

e Source comment lines are also displayed.

¢ The lines of source code are treated as comments within the lines of disassembly code. You can only
set breakpoints or run your program on lines of disassembly code.

Note: The Mixed window cannot be opened if the source code is not available.
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Figure 10. Mixed Window

Each of the source windows has menus. The menus are the same as the Debug Session Control window
menus with the following exceptions:

¢ File menu—Save window in file

This choice enables you to save the current source view to a named file.
e From the View menu, you can:
— Locate strings of text:
- Alphabetic and numeric
- A maximum of 256 characters
- Uppercase and lowercase characters
— Scroll to a particular line.

You can also use the Scroll to Line Number window to set a breakpoint. In the Line field, enter
the line number and then click the Breakpoint button.

— View include files.

— Change the text file name (specify a file name to be used as the source in the current view).

— Select a different view of your application.
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¢ Breakpoints menu—Toggle at current line choice.

Toggle at current line sets a breakpoint on the current line or deletes an existing breakpoint from the
current line.
¢ Monitors menu—Monitor expression

Enables you to monitor expressions or variables and add them to various monitor windows.

Note: If you need help with any of the menus, press F1 while the menu is selected.

Executing a Program

You can execute a program from any of the source windows (Source, Mixed, or Disassembly) using step
commands or the Run command.

Step commands Step commands control the execution of the program. The step commands are
located on the tool bar of the source windows and under the Run menu of the
source windows.

Run command The Run command runs the program until a breakpoint is encountered, the program
is halted, or the program ends. You can start the Run command from the Run
button (located on the tool bar) or the Run menu of the source windows.

When you execute a program, a clock icon is displayed to indicate that the program
is running and that the program might require input to continue to the next break-
point or termination of the program.
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Monitors Windows

To open Monitors windows, from the Monitors menu of the Debug Session Control window, click any of
the following choices:

Call stack
Registers

e Storage

Local variables

These windows are also accessible from the tool bar of the source windows. See [‘Using the Tool
[Buttons” on page 9| for information about the tool bar.

Viewing Active Functions for a Particular Thread

You can view all of the active functions for a particular thread including system calls from the Call Stack
window.

To display the Call Stack window, click Call stack (located within the Monitors menu) or click the Call

Stack button [E] (located on the tool bar).

= Call Stack - Thread:1 il il |
File Options Windows Help

2 g=1E1

Function | Source

_cinit cinit
startup cstart

Figure 11. Call Stack Window

Each Call Stack window displays call stack information for only one thread. When the state of the program
changes, such as when you execute the program or you update displayed data, the Call Stack window
changes to reflect the current state. You can double-click any call stack entry to display the source code
for that entry. The line that calls the next stack entry is selected. The remaining stack size shows the
bytes left in the stack for the thread.

Note: The stack might not be displayed correctly if the code does not follow standard calling conventions,
or if you step into optimized code.
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Menus

From the menus of the Call Stack window you can:

¢ Save the contents of the Call Stack window in a file. Choose the file name by clicking Options and
then Display style. Enter the file name in the Save file field.

¢ End the debugging session.

¢ Select the type of information displayed in the window and choose how items are displayed.

¢ Reset all your window settings to their original settings.

¢ Enable or disable the tool bar.

e Select whether you want hover help to be shown.

¢ Select to display the information area in the window.

¢ View a list of open windows and select a window from the list to display it.

¢ Display help.

Note: If you need help with any of the menus, press F1 while the menu is selected.

Viewing Registers for a Particular Thread
You can view all the processor registers for a particular thread from the Registers window.

To display the processor registers and flags, click Registers (located within the Monitors menu) or click
the Registers button I (located on the tool bar).

= Registers - Thread:1 v [~
File Options Windows Help
General Status Flags
EFLAGS 00000202 1]
EAX  00000O0D1 CF 0
EEX 0400E93C PF 0
ECx 00001042 AF 0
EDX 0400B454 ZF 0
EEP 0A00AFFA4 SF 0
ESPF 0400DAFBES TF 0
ESI oooooo0oo IF 1
EDI 0400E921 DF 0
0OF 0
10PL 0
NT 0
RF 0
Vi 0
] ]
- [+] |[+ [+]

Figure 12. Registers Window

The contents of all of the registers except floating-point registers are displayed in hexadecimal. Registers
that change after a run or a step are highlighted. To update a register, double-click the register and a
multiple-line field is displayed. Type over the contents and press Enter. If you decide not to change the
value, press Esc.
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In the Registers window, floating-point registers are displayed as floating-point decimal numbers. They can
be updated with a floating-point decimal number or with a hexadecimal string that represents a floating-
point number.

Menus

From the menus of the Registers window you can:

¢ End the debugging session.

¢ Select the font to be displayed in the window, select the items you want displayed in the window,
restore the defaults, and enable or disable the tool bar.

¢ Reset all your window settings to their original settings.

¢ Select whether you want hover help to be shown.

e Select to display the information area in the window.

¢ View a list of open windows and select any open window to display that window.

¢ Display help.

Note: If you need help with any of the menus, press F1 while the menu is selected.

Viewing Storage Contents and Addresses
The Storage window shows the storage contents and the address of the storage.

To display the Storage window, click Storage (located within the Monitors menu) or click the Storage

button [#£] (located on the tool bar).
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Figure 13. Storage Window

Multiple storage windows can display the same storage. When you run a program or update displayed
data, the Storage window is updated to reflect the change.

To update the storage contents and all affected windows, double-click in the multiple-line field that is dis-
played. Type over the contents of the field. If you decide not to make the change, press Esc.

To specify a new address location, type over the address field in the Storage window. The window scrolls
to the appropriate storage location.
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Menus

From the menus of the Storage window you can:

¢ Save the contents of the Storage window in a file. Choose the file name by clicking Options and then
Display style. Type the file name in the Save file field.

¢ End the debugging session.

¢ From the Options menu you can:

1

2
3
4
5
6

Select the font to be displayed in the window.

Select the items you want displayed in the window.

Restore the defaults.

Enable or disable the tool bar.

Fill memory with a specific character or hexadecimal pattern.
Identify the expression you want to monitor.

The expression evaluator used is based on the context. For example, if you display the Storage
window by clicking Monitor expression (located within the Monitors menu), the evaluator used is
based on the context in the Monitor Expression window. However, if you display the Storage
window first and then click Monitor expression (located within the Options menu of the Storage
window), the evaluator used is based on the context of the stopping thread.

Note: You cannot look at variables that have been defined using the #DEFINE preprocessor
directive. If the variable is not in scope when the monitor is opened, the default address is dis-
played. If the variable goes out of scope, the address is changed to a hex constant.

If you select the Enabled monitor check box, the monitor updates the stop value of the program
to the actual value in storage. However, a disabled monitor suspends this updating and reflects
the stop value or the value held when the monitor was disabled.

Reset all your window settings to their original settings.
Enable or disable the tool bar.

Select whether you want hover help to be shown.
Select to display the information area in the window.

View a list of open windows and select any open window to display that window.

Display help.

Note:

30

If you need help with any of the menus, press F1 while the menu is selected.
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Monitoring Local Variables

You can monitor and change the local variables (static, automatic, and parameter) for the current exe-
cution point in the program from the Local Variables window. The contents of the Local Variables window
change each time your program enters or leaves a function.

To display the Local Variables window, click Local variables (located within the Monitors menu) or select

the Monitor Expression button (located on the tool bar).

= pCa ariable Ead -

-Eile Edit Options Windows Help

byte count || 67153908 [+
seed 67118513

Figure 14. Local Variables Window
Modifying Variables

To modify the value of a variable, double-click the value. When the information area is displayed, type the
new value and press Enter.

Menus

From the menus of the Local Variables window you can:

¢ End the debugging session.

¢ Delete, select, deselect, show other elements, or change representation of the variables. You can
copy the selected local variable data to the clipboard. You can also save the Local Variables window
contents in a file. Select Options, Debugger settings, and then Monitor properties from the Debug
Session Control window or any of the source windows and enter the file name in the Save file field.

¢ Control how the contents of variables display and set debugger options.

¢ View a list of open windows and select any open window to display that window.

¢ Display help.

Note: If you need help with any of the menus, press F1 while the menu is selected.
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Monitoring Other Variables and Expressions

The debugger has four other windows that enable you to monitor and change variables and expressions.
These windows are as follows:

e Popup Monitor
e Program Monitor
¢ Private Monitor
e Storage Monitor

A Popup Monitor window monitors single variables or expressions. This window is associated with a spe-
cific source window and closes when the associated window closes.

The Program Monitor, Private Monitor, and Storage Monitor windows are used as collectors for individual
variables or expressions that might be of interest to you.

The difference between the Private Monitor window and the Program Monitor window is the length of time
that each remains open. The Program Monitor window remains open for the entire debugging session.

The Private Monitor window is associated with the source window from which it was opened and closes
when its associated view is closed.

Modifying Variables

To modify the value of a variable, double-click the value. When the information area is displayed, type the
new value and press Enter.
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Expressions Supported

This section describes the expression language supported by the debugger, which is a subset of C. This
includes the operands, operators, and data types.

Note: You can display and update bit fields for C code only. You cannot look at variables that have
been defined using the #DEFINE preprocessor directive.

Supported Expression Operands

You can monitor an expression that uses the following types of operands only:

Operand Definition
Variable A variable used in your program.
Constant The constant can be one of the following types:

¢ Fixed or floating-point constant.

Note: The largest floating-point constant is 1.8E308. The smallest floating-point
is 2.23E-308.

¢ A string constant, enclosed in quotation marks (* ")

¢ A character constant, enclosed in single quote marks (* *)

Registers In the case of conflicting names, the program variable names take precedence over
the register names. For conversions that are done automatically when the registers
display in mixed-mode expressions, general purpose registers are treated as unsigned
arithmetic items with a length appropriate to the register.

If you monitor an enumerated variable, a comment displays to the right of the value. If the value of the
variable matches one of the enumerated types, the comment contains the name of the first enumerated
type that matches the value of the variable. If the length of the enumerated name does not fit in the
monitor, the contents display as an empty entry field.

The comment (empty or not) lets you distinguish between a valid enumerated value and an invalid value.
An invalid value does not have a comment to the right of the value.

You cannot update an enumerated variable by entering an enumerated type. You must enter a value or
expression. If the value is a valid enumerated value, the comment to the right of the value updates.

Bit fields are supported for C compiled code only. You can display and update bit fields, but you cannot
use them in expressions. You cannot look at variables that have been defined using the #DEFINE pre-
processor directive.

Supported Expression Operators

You can monitor an expression that uses the following operators only:

Table 1 (Page 1 of 2). Supported Expression Operators

Operator Coded as
Subscripting a[b]
Member selection a.b or a->b
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Table 1 (Page 2 of 2). Supported Expression Operators
Operator Coded as
Size sizeof a or sizeof (type)
Logical not la
One’s complement "a
Unary minus -a
Unary plus +a
Dereference

Type cast (type) a
Multiply a*b
Divide alb
Modulo a%b
Add a+b
Subtract a-b
Left shift a<<b
Right shift a>>b
Less than a<b
Greater than a>b
Less than or equal to a<=b
Greater than or equal to a>=b
Equal a==b
Not equal al=b
Bitwise AND a&b
Bitwise OR alb
Bitwise exclusive OR a™b
Logical AND a&&hb
Logical OR allb

Supported Data Types

You can monitor an expression that uses the following typecasting operations:

¢ 8-bit signed byte

e 8-bit unsigned byte

¢ 16-bit signed integer

¢ 16-bit unsigned integer
e 32-bit signed integer

e 32-bit unsigned integer
¢ 32-bit floating-point

¢ 64-bit floating-point

e 128-bit floating-point

¢ Pointers

¢ User-defined types

34 ICAT Debugger



Notices

References in this publication to IBM products, programs, or services do not imply that IBM intends to
make these available in all countries in which IBM operates. Any reference to an IBM product, program,
or service is not intended to state or imply that only IBM’s product, program, or service may be used. Any
functionally equivalent product, program, or service that does not infringe any of IBM's intellectual property
rights or other legally protectable rights may be used instead of the IBM product, program, or service.
Evaluation and verification of operation in conjunction with other products, programs, or services, except
those expressly designated by IBM, are the user’s responsibility.

IBM may have patents or pending patent applications covering subject matter in this document. The fur-
nishing of this document does not give you any license to these patents. You can send license inquiries,
in writing, to the IBM Director of Licensing, IBM Corporation, 500 Columbus Avenue, Thornwood, NY,
10594, USA.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part
of the materials for this IBM product and use of those Web sites is at your own risk.

Copying and Distributing Softcopy Files

For online versions of this book, we authorize you to:

¢ Copy, modify, and print the documentation contained on the media, for use within your enterprise,
provided you reproduce the copyright notice, all warning statements, and other required statements on
each copy or partial copy.

¢ Transfer the original unaltered copy of the documentation when you transfer the related IBM product
(which may be either machines you own, or programs, if the program's license terms permit a
transfer). You must, at the same time, destroy all other copies of the documentation.

You are responsible for payment of any taxes, including personal property taxes, resulting from this
authorization.

THERE ARE NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING THE WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

Some jurisdictions do not allow the exclusion of implied warranties, so the above exclusion may not apply
to you.

Your failure to comply with the terms above terminates this authorization. Upon termination, you must
destroy your machine readable documentation.
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Trademarks

The following terms are trademarks of the IBM Corporation in the United States or other countries or both:
IBM

Intel is a registered trademark of the Intel Corporation.

Windows and Windows NT are either registered trademarks or trademarks of Microsoft Corporation in the
United States and/or other countries.

Other company, product, and service names may be trademarks or service marks of others.
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